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What We’ll Cover 

• Enabling Database connections through Microsoft Excel 

• Brief overview of Database Structure – defining tables and fields. 

• Accessing the data stored in the SQL Database via the MS Query Tool.  

• Creating Simple Maintenance Item lists. 

• Queries against items with UDFs attached 

• Setting Criteria on queries to include/exclude selected items. 

• Returning and formatting data in Microsoft Excel. 

• Use of Tables and Auto-Filter options in Excel 

• Overview of commonly accessed tables in Foundation’s database for items stored in 

• Job Cost and General Ledger History 
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Preface: A brief explanation of database structure and queries:  

 

(From Searchsqlserver.com) 

http://searchsqlserver.techtarget.com/sDefinition/0,,sid87_gci212885,00.html 

 

“Definition- A relational database is a collection of data items organized as a set of formally-

described tables from which data can be accessed or reassembled in many different ways 

without having to reorganize the database tables. The relational database was invented by E. F. 

Codd at IBM in 1970.  

The standard user and application program interface to a relational database is the structured 

query language (SQL). SQL statements are used both for interactive queries for information 

from a relational database and for gathering data for reports.  

In addition to being relatively easy to create and access, a relational database has the important 

advantage of being easy to extend. After the original database creation, a new data category 

can be added without requiring that all existing applications be modified.  

A relational database is a set of tables containing data fitted into predefined categories. Each 

table (which is sometimes called a relation) contains one or more data categories in columns. 

Each row contains a unique instance of data for the categories defined by the columns.” 

A quick preview of how FOUNDATION’s Job table relates to the Customer table: 

 

 

 

 

 

 

The Job table houses most of the fields on the Job Maintenance window. The Customer table 

houses the information from the Customer Maintenance window.  Individual tables relate to 

each other by common fields within the tables.  If you have a Job Record in Foundation, 

chances are you have a customer attached to that Job Number.  Foundation’s database uses 

the field named customer_no to join these two tables.  This way, we can access the Job table, 

and then pull in all associated information (fields) stored in the Customer table.  

We will see more examples later, but each individual table stores minimal data related to other 

tables to reduce database size and overhead.  The customer_no (customer number) is stored in 

the Job table, but the customer name, address, contact information, etc. is not.  The specific 

   TABLES 

  FIELDS 



customer details are stored in the Customer table. The link between the two tables joins the 

information together when it is queried from the source.  

(From www.About.com:) 

http://databases.about.com/od/specificproducts/a/whatisadatabase.htm 

 

“Queries are the primary mechanism for retrieving information from a database and consist of 

questions presented to the database in a predefined format.” 

 

There is a lot of good reading on the subject from beginning to advanced topics on these 

websites. 

 

Actually locating the correct tables and fields in any database takes time and patience.  The 

easiest queries to write access a single table.  These are typically queries against maintenance 

type records (employee files, job files, vendor files).  Some queries require calculations to sum 

amounts or return minimum or maximum values from a particular table (timecard history, job 

history).  Other queries require the linking of multiple tables in order to return the desired 

information (job budgets/change orders/costs/income).  

 

We will visit many of these options and show some of the more readily accessed tables in the 

following lessons. 

 

 

Excel Resources on the Web: 

 

Mr. Excel – An excellent forum. Many Google searches return topics answered in these forums. 

 

http://www.mrexcel.com/forum/index.php 

 

Contextures – A well-organized menu of Excel tips and tricks. 

 

http://www.contextures.com/tiptech.html 

 

Microsoft Office Online – A good resource. (Some may find this site difficult to 

navigate/search.) 

 

http://office.microsoft.com/en-us/excel/FX100646961033.aspx 

 

University of Wisconsin – A well-documented source with many screen shots. 

 

http://www.uwec.edu/help/excel03.htm 

 

Allen Wyatt’s Excel Tips – Nicely formatted for different versions of Excel. 

 

http://exceltips.vitalnews.com/ 
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WikiHow – User Edited “how to” site (start your search with “excel”). 

 

http://www.wikihow.com 

 

Ozgrid.com 

 

http://www.ozgrid.com/Excel/ 

 

Google– Everything I learned, I learned with the help of Google.  Search for what you are 

looking for and you will find most of the answers with Google’s help.  Many searches return 

data from the sites listed above.  I find it easier to start searching with Google as opposed to 

visiting a specific website. 
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Enabling Data Connections in Excel  

With the release of Excel 2007, heightened security settings have been enabled as a default.  

Before performing a query, you will need to change a few settings in order to pull data into Excel 

Worksheets. 

In Excel 2007 Click on the Office button in the upper left hand corner and select Excel Options in 

the lower right-hand corner.  If you are using Excel 2010, click on the File button in the upper left-

hand corner and select Options. 

 

 

 

 

Excel 2007 

Excel 2010 
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Click on Trust Center in the left-hand column, then click Trust Center Settings… in the lower-

right hand corner. 

 

Click on External Content in the left-hand column. 

 

Select the Security Setting appropriate for the level of confidence you have in the users of the 

Excel application. 

- If you choose “Disable all Data Connections,” please close the book, turn off your computer, 

and we thank you for attending. 
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- If you select “Prompt user about Data Connections,” every time you open a workbook with a 

query, Excel will warn you with the following: 

 

 

- The last option is to “Enable all Data Connections.”  This is the best choice IF you trust the source 

of all Excel files in your office.  If you are busy downloading Excel files off the internet, or opening 

Excel Files that came as attachments on emails from complete strangers, this option may not be 

the best for you.  
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Sample Report / Lesson 1 

Employee Phone List 

 

Tasks: Accessing data through MS Query 

 Formatting queried data in Excel 

 Editing Queries 

 Sorting data within MS Query 
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Lesson 1: Accessing Queries through Microsoft Excel 

1. Click on the “Data” tab on the Ribbon, and select Get External Data Group > From Other 

Sources > From Microsoft Query. 

 

For those of you still using Excel 2003 or earlier, from the main toolbar select:  Data > Get 

External Data > New Database Query. 

 

 

 

 

     

 

 

 

 

 

 

 

 

 

 

 

2. Select the Database that you want to query.  This should be the primary database that 

houses the information for Foundation Software.  Uncheck the option to Use the Query 

Wizard to create/edit queries.  Once the Database is selected, click “OK” in the upper right-

hand corner. 
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3. On the SQL Server Login window, enter your dba login and password (or your FOUNDATION 

user ID and password). 

 

           
 

You have now accessed the Microsoft Query function.  This is where we will build the 

queries, by selecting the appropriate tables and fields.  Once the selection process is 

complete we will then return the data to Excel. 
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4. For this first example, we will access the employee table.  Scroll down to the “employees” 

table. Highlight it, and click [Add]. You will notice that the table appears in the upper left-

hand corner of the window.  Click the [Close] button on the “Add Tables” dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. To see more of the fields within the table, click and hold on the separator line and drag the 

top portion of the window to make more room. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click here and drag the 

line down. 
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Click, hold and drag 

here to expand the 

size of the table box. 

6.  Scroll down within the table and locate 

the employee_id field. Double click on the 

field to add it to the preview window. 

(You may also drag the item from the table 

box and drop it in the header area)  

Continue adding the following fields from 

the Employees table: 

Last_name 

First_name 

phone 

The query window shows a preview of the 

data selected.  This looks very close to the 

example cited in the beginning of the lesson. 
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The last name is now sorted in ascending 

alphabetical order. 

We are now ready to return the query to the 

excel spreadsheet. 

8.  Click the “Return Data” icon. 

7.  Sort the list by last name. Click on the 

last_name field in the lower preview 

pane to highlight the column and then 

click on the sort ascending button on the 

toolbar. 
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9. Excel will now ask where you want to return the data on the spreadsheet.  In most cases, 

you will want to start the data in cell A1.  Click [OK] to accept the selection. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Congratulations, some of you have completed your first query! …. Then reality sets in.   
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Say you want to format the “phone” column as a phone number (###) ###-####.  Most would 

think this is as simple as a right-click on the column and choosing the appropriate format. Since 

queries are dynamic data that may be changed in the software application (FOUNDATION), the data 

is “refreshed” every time the excel file is opened. When this happens, the data tends to “float” in 

the cell, and the columns do not maintain the selected formatting.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

Editing a Query 

1. Right click in an area where there is 

data in the spreadsheet and select 

“Table” then “Edit Query.” 

In Excel 2003, right-click and select 

“Edit Query.” 

Note: if you click in a blank cell (ie: cell 

F20, you will not have the option to “Edit 

Query,” as you are not on a section of 

the spreadsheet that has data returned 

from 

The cells are alternating colors of blue, 

and an Auto-Filter is automatically 

enabled when the data is returned to the 

spreadsheet. 
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We are now returned to the Query 

editing mode. 

 

2. Double click the header of the 

phone column to access the 

Edit Column box. 

3. In the Field…ummm field, type 

the following: abs(phone) 

This will return the absolute 

value of the data to the 

spreadsheet. Click [OK] and 

return the data to Excel. 

 

Double Click  
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We are almost ready to save this file, but first we must define a number of properties to ensure 

the file opens and refreshes automatically. 

 

 

 

 

 

 

 

Initially the data looks the same, but now 

when you format the column for a phone 

number, the formatting will stay. 
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Sample Report/Lesson 2 

Employee Phone List 

 

Tasks: Saving Password in MS Query 

 Enabling Automatic Refresh 
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1. On the ribbon, select “Data” tab > Connections > Properties.   

 

 
 

2. On the “Usage” tab of the Connection Properties window, select Refresh data when opening 

file. 
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3. Click on the “Definition” tab of the Connection Properties dialog box, and select Save 

Password. 

          
 

4. You will receive a warning from Microsoft about saving passwords within the Excel file.  

Click [Yes] to close this dialog box (more on this later). 

 

 
 

You may notice the screen “blink” for a second as it gathers the data from the Foundation SQL 

Database.  More involved queries may display a message that Excel is gathering data. 
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Sample Report/Lesson 3 

Employee Phone List 

 

Tasks: Editing Column Headers in MS query 

 Adding fields to existing Query 
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Editing column Headings: 

 

We like the results, but we want to tweak some of the items to make the list look more 

presentable. 

 

Notice the column headings: 

 
 

These are the field names from the query, and the “phone” column heading is altogether gone. 

 

We need to access the query mode once again.  

 
1. Right click in an area where there is data in the spreadsheet and select “Table” then “Edit Query.” 

 
 

  

2. Double click the column heading that 

you wish to change. 

3. In the Edit Column box, note the 

Column Heading field. 
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4. Type a more appropriate heading here.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Repeat this process across all of the columns in the data window at the bottom of the 

screen. 
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Our Query is looking better.  

 

 
 

6. Return the data to Excel. 
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Sample Report / Lesson 4 

Employee Phone List 

 

Tasks: Adding Fields / Columns to MS Query 

 Preserving Layout in Excel 
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Lesson 4: Adding more fields to an existing query: 

 

I have a need to enter the middle initial to this query.   

1. Access the ability to “edit query”. 

 

 
 

 

 
 

 

 

 

  

2.  Click, hold, and drag the 

“middle_initial” field to the appropriate 

column in the preview window. 

3.  Drag the field and drop it in the 

appropriate position. 
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4. Return the Data to Excel.  You will notice that the middle initial did not return to the 

spreadsheet in the desired location.  It is at the end of our list.   

 

 
 

 

 
 

 

The important thing to remember is, once the Excel file is in the correct format/layout, you 

should enable the option to Preserve column/sort/filter/layout. 

 

This will maintain the layout based on what you see on screen at the time that you select this 

option. 

 

 

 

 

 

 

5.  Right click on a cell within the table 

and select Table > External Data 

Properties. 

6.  Uncheck Preserve column 

sort/filter/layout and click [OK]. 

7.  Refresh the data manually by right 

clicking, and choosing “Refresh Data”. 

You will notice the excel file is now in 

the correct format. 
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Sample Report/Lesson 5 

Employee Phone List 

 

Tasks: Adding Criteria to MS Query 

 Removing columns from MS Query  
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Lesson 5: Adding Criteria to the Query: 

 

Imagine that I do not want terminated employees to show on the phone list.  We need to tell the 

query to ignore, or suppress the terminated employees. 

 

This is where a good amount of thought may be required for queries. What to include or exclude 

on a list or report. Much like FOUNDATION “Criteria” tabs on reports, we will assign filters to show 

only the data we request. 

 

1. Once again, access the MS Query tool. 

2. On the toolbar, select View > Criteria. 
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          You will notice the Criteria Field section is now available in the query designer. 

 

3. Click and drag the “date_terminated” field into the criteria toolbar: 

 

 
 

4. Double Click the empty Value field to the right of the word “Value” to open the Edit Criteria 

box.   
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5. Put on the thinking caps and try to remember your statistics class from 9th grade.  What do 

we want to determine?  In this case we only want to show employees who are not 

terminated.  The “Operator” in this example would be:   

 

          
 

Yes… “is Null”, or is blank.  If the employee terminated date is blank, we want him to show 

up on the current phone list. 

 

 

You may notice that the data in the preview window at the bottom flickers for a second as 

the terminated employees are removed from the query. 
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6. If you want to verify this information, drag the date_terminated into the last column in the 

preview pane.  Based on our criteria, this column should be blank. 

 

          
 

If we remove the “Is Null” criteria from the criteria pane, we should then see the terminated 

employees. 
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Note: The field that we are setting criteria on does NOT need to be part of the returned 

data, we offer this example so you may validate that the criteria selection is performing as 

intended. 

 

Here is the same data with the “is null” criteria enabled.  Notice Carol Brennan and Detroit 

Resident are now gone from the list, as they are terminated. 

 

          
 

7. After validating the data, click on the date_terminated column to highlight it, and hit the 

<Delete> key on the keyboard.  This will remove the column from the query, but it will not 

remove the criteria we set a few moments ago. 
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     After pressing “delete” on the keyboard 

         
 

8. Once again return the data to Excel and save the file. 
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Lesson 6: Concatenate function in MS Query  

1. In the Query mode, with the employee table selected, we click on the first column header in 

the data preview area and type in the following: 

 

last_name+’, ‘+first_name 
 

 
 

2. Tab out of the field to view the results. 

 

       
 

 

 

  

This is only the beginning… 

Combining text fields is one option. You 

can write rather complex calculations 

against numeric data from tables. 

This is not recommended for the faint of 

heart, as the formula logic in Excel does 

not always relate to writing a formula in 

the Query mode. 

A lot of trial and error will be needed in 

order to create the desired results. If you 

are better at writing formulas in Excel, by 

all means, return the data to Excel, 

perform the calculations on the 

spreadsheet and hide unneeded columns. 

(you may thank me later). 
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Lesson 7: Creating queries accessing User Defined Fields 

User defined fields are available in most maintenance tables across the Foundation database. 

In this example, we will create a list of driver’s license numbers and their associated expiration 

dates. 

1. Log into Foundation and select Tools – User Defined Fields. Scroll down to the Employees 

table. 

           

2. Click [New] to add whatever type of field you want. A number of fields are noted here, but 

some other examples are: 

• Certification Dates 

• Drug Test dates 

• Spouse’s name and contact information 

• Nextel Direct Connect Numbers 

• Work Permit Expiration Dates 
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Once the fields are added in the tools menu, they become fields in the Foundation Program 

and Foundation database. If they are part of the database, we can query the information for 

a custom list. 

           

When executing a query that accesses User Defined Fields, we need to look to special tables 

in order to find the data.  Since User Defined Fields are “user Defined”, no two FOUNDATION 

users will have the same tables. When you create a UDF, FOUNDATION creates a “view” or 

virtual table to store the complete data. These virtual tables are easily located because they 

are named as follows: 

      V_UDF_EMPLOYEES 

This “View” contains all of the information that the employees table has, plus the user 

defined fields. 

3. To create a custom query/list of employee’s driver’s license numbers and expiration dates, 

we need to access a new query and select the V_UDF_EMPLOYEES table. 
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4. If we add a date to an Employee Record in FOUNDATION, and refresh the query, we can see 

the data appear on our preview screen. 

           

          Data has been added to FOUNDATION, and the record has been saved. 

  

Note: All of the UDF name fields 

are at the bottom of this table. 

All other items are in alphabetical 
order just like the “employees” 

table 
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5. Click the Query Now button (an exclamation point) on the query toolbar to refresh the data 

in the query mode. 

          

         The newly added information in the UDF shows on the query screen. 
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6. Return the Data to Excel and format the column containing the date: 
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TOP 20 tables for use with MS Query. 

 

There are over 2,000 individual tables in FOUNDATION’S database. 

The following list of Foundation Software Database tables is a representation of the most commonly 

sought after tables when creating reports through queries. 

These tables break down into two simple categories; maintenance-related tables and history-related 

tables. 

The easiest way to start is by creating the list. 

For a simple Chart of Accounts, look for the G/L Account List.  In the database, this table is known as 

…Accounts.  There are 52 fields within this table.  What is important is the ability to match the 

table.field name to the screen item in Foundation. 

 

  

 

This table is created as a reference so you may get familiar with identifying table and field names within 

the database as they relate to the more “public” face of Foundation Software. 

 

When reviewing the “Top 20” tables, we will look at the most used fields within the tables as well. 

 

company_no 

account_no 

description 

debit_credit 

apply_subdivision 

inc_exp_type 

overhead_percent 

overhead_formula_percent 

force_job_costing 

jc_income_expense 

cash_flag 

bonding_class 

record_status 

row_modified_by 

row_modified_on 

row_unique_id 

ovhd_alloc_income_expense 

percent_to_allocate 

overhead_weight_factor 

account_id 

company_id 

direct_deposit_format 

dir_dep_exp_dsg_report_no 

direct_deposit_pr_file 

ach_dest_routing_num 

ach_dest_name 

 

ach_origin_routing_num 

ach_origin_name  

ach_origin_reference_code 

ach_company_name 

ach_company_id 

ach_pr_entry_desc 

ach_pr_discretionary_data 

ach_pr_emp_identifier 

ach_pr_emp_name_format 

dir_dep_exp_dsg_report_id 

condense_on_cash_rec 

statement_category_no 

bank_account_num 

bank_account_type 

ach_balanced_file 

statement_category_id 

include_in_canned_financials 

ach_origin_dfi_id 

positive_pay_exp_dsg_report_no 

positive_pay_export_file 

positive_pay_exp_dsg_report_id 

ach_use_origin_routing_bal_dfi 

ach_use_dest_routing_bal_dfi 

ach_origin_type 

account_type 

gl_history_report_rollup 
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Table Name:  Accounts 

 

FOUNDATION Location: General Ledger > Maintenance > Accounts 
 

In A Query Window, the most common fields used in the accounts table are: 

 

account_id Account number 

description G/L account name 

debit_credit What “type of account it is  

 

 

 
 

 

 

 

 

 

 

 #1 
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Table Name: Vendors 

 

FOUNDATION Location: Accounts Payable > Maintenance > Vendors 

 

vendor_id Vendor number 

name Vendor description/name 

address_1 First line address 

address_2 Additional address line 

city City 

state State 

zip_code Zip code 

 

 
 

Additional Vendor fields of interest: 

 

wc_certificate Y or N to “W/C Certificate on file” 

wc_date_expires W/C insurance certificate expiration date 

ins_certificate Y or N to “Insurance Certificate on file” 

ins_date_expires Insurance certificate expiration date 

default_gl_account Uhhhhh…. the default G/L account 

tax_id Default sales tax authority 

 

 

 #2 
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Table Name: Customers 

 

FOUNDATION Location: Accounts Receivable > Maintenance > Customers 

 

customer_id customer number 

name customer description / name 

address_1 First line address 

address_2 Additional address line 

city City 

state State 

zip_code Zip code 

phone_voice Phone Number 

 

 
 

Additional Customer fields of interest: 

 

client_since How long client has been an active customer 

income_type_id Default income type for A/R invoicing 

tax_id Default A/R sales tax ID 

default_tax_type Sales/Use/N/A 

 

 

 

 

 #3 
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Table Name: Jobs 

 

FOUNDATION Location: Job Costing > Maintenance > Jobs 

 

job_id job number 

description Job description / name 

address_1, 2, city, state, zip_code Address information per other tables 

customer_id Default customer number on job record 

job_status Active/inactive/closed/overhead 

completion_date Job End Date from the “Addl” tab 

geo_are_id Geographic area number 

project_manager_id  Project manager number 

project_class_id Project class number 

 

 
 

Associated tables: 

 

customers: contains customer name and addition customer related information 

geographic_areas: Geographic area descriptions 

project_managers: Project Manager Descriptions 

project_classes: Project class descriptions 

 

Additional Job fields of interest: 

 

original_contract Original Contract amount on “General” tab 

original_cost Original Estimated cost amount (“General” tab) 

 

 #4 
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Table Name: Items 

 

FOUNDATION Location: Inventory > Maintenance > Items 

 

item_id Inventory item number 

description Item name 

stocking_unit_id Stocking unit of measure 

standard_cost Standard cost 

primary_item_category_id Primary item category 

 

 
 

Additional Item fields of interest: 

 

item_2_category_id, item_3_category_id, etc. Additional categories 2 -6 

last_cost Last cost transaction from receipt function 

last_date_purchased Last date received from receipts function 

bin_location_id Bin number 

 

 

 

 

 

 #5 
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Table Name: Equipment 

 

FOUNDATION Location: Equipment > Maintenance > Equipment Items 

equipment_id Equipment Number 

description Equipment description / name 

eq_category_id E/Q Category number 

license_expiration License expiration date 

license_fee License fee 

model_year Model year 

 

 
 

Additional Customer fields of interest: 

 

manufacturer Manufacturer 

make_model Make and Model information 

ownership Owned / Rented / Leased 

distributor Distributor 

 

 

 

 #6 
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Table Name: Employees 

 

FOUNDATION Location: Payroll > Maintenance > Employees 

 

employee_id Employee number 

last_name Last name 

first_name First Name 

middle_initial Middle Initial 

date_hired Hire Date 

date_terminated Termination Date 

ss_id Social Security Number 

union_id  Union Number 

 

 
 

Associated tables: 

 

Emp_direct_dep: Employee direct deposit information 

Emp_rate_changes: Employee pay rate changes 

Emp_ded: Employee miscellaneous deduction information 

Emp_taxes: employee tax information (Federal, State, Local withholding information) 

 

 

 

 

 

 

 

 

 #7 

SPECIAL NOTE: Are you looking for UDF (User Defined Field) information with your maintenance tables?   Simple 

add a V_UDF_ in front of the table name and you now have all the information from the basic maintenance table 

AND all of your User Defined Fields.  IE: V_UDF_JOBS = all job maintenance fields and the user defined fields.   (…and 

no, this does not count as tables 8-14, that would be cheating) 
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Table Name: job_budgets 

 

FOUNDATION Location: Job Cost > Maintenance > Jobs > Budget Tab 

 

job_id Job number 

cost_code_id Cost code number 

cost_class_id Cost class number 

orig_est_dollars Original estimated dollars (per code and class) 

orig_est_units Original estimated units 

 

 
 

Associated tables: 

 

Jobs, cost_codes, cost_classes: all tables used to pull in descriptions for associated items 

 

Additional job_budgets fields of interest: 

 

phase_id For phased companies 

 

 

 

 #8 
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Table Name: job_chg 

 

FOUNDATION Location: Job Cost > Daily Transactions > Enter Change Orders 

 

job_id Job number 

change_order_id Change order number 

date_booked Change order date 

status Approved, Estimate, Pending, Rejected, Internal 

tot_income_adj Total income adjustment 

tot_cost_adj Total cost Adjustment 

comments Change order comments 

 

 
 

Associated tables: 

 

Jobs: to pull in descriptions for associated items 

 

Additional job_budgets fields of interest: 

 

owner_co_id Owner Change Order number 

tot_unit_adj Total unit adjustment 

tot_quantitiy_adj Total quantity adjustment 

 

 

 

 #9 
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Table Name: job_chg_budgets 

FOUNDATION Location: Job Cost > Daily Transactions > Enter Change Orders > 

“Distribution” tab 

 

job_id Job Number 

change_order_id Change order number 

cost_code_id Cost code number 

cost_class_id Cost class number 

cost_adj Cost adjustment per code and class 

unit_adj Unit adjustment 

 

 
 

Associated tables: 

 

Job_chg, Jobs, Cost_codes, cost_classes: all tables used to pull in descriptions for associated 

items 

 

Additional Job_chg_budgets fields of interest: 

 

Phase_id For phased companies 
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Table Name: job_chg_cost_codes 

 

FOUNDATION Location: Job Cost > Daily Transactions > Enter Change Orders > 

“Distribution” tab > Income Amount 

 

job_id Job Number 

change_order_id Change order number 

cost_code_id Cost code number 

income_adj income adjustment per cost code (if enabled) 

 

 
 

Associated tables: 

 

Job_chg, Jobs, Cost_codes: all tables used to pull in descriptions for associated items 

 

Additional Job_chg_cost_codes fields of interest: 

 

phase_id For phased companies 

quantity_adj Quantity adjustment per cost code 
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Table Name: v_job_history 

 

FOUNDATION Location: Job Cost > Reports > Job History Detail 

 

Job_id Job Number 

Job_description Job description 

Cost_code_id Cost code number 

Cost_code_description Cost Code Description 

Cost_class_id Cost Class number 

Cost_class_description Cost Class Description 

Cost Cost 

Units Units/Hours 

Date_booked Date posted to G/L & Job Cost 

 

 
 

Associated tables: 

 

None – all of the associated data is in this table – YEAH!!! 

 

Additional v_job_history fields of interest :  

 

Too many to mention.  Basically, if it is cost-related and shows up on a Job History Detail 

Report, it is in this table.  Employee names, inventory items, equipment items, journal 

descriptions, source module, earn codes, departments, vendors – all of the IDs and Descriptions 

for these items are contained within this table. 
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Table Name: ap_invoice_d 

 

FOUNDATION Location: Accounts Payable > Daily Transactions > Posted Invoice 

Distribution Detail 

 

Voucher_id A/P Invoice transaction number 

Account_id Basic G/L account number (no divisions) 

Job_id Job Number 

Cost_code_id Cost code number 

Cost_class_id Cost class number 

Amount $ amount from A/P invoice distribution 

 

 
 

Associated tables: 

 

Ap_invoice_h: This table carries the vendor, invoice and posting date information – pretty much 

required if you want to make any sense out of the ap_invoice_d table. 

Jobs, cost_codes, cost_classes, accounts: All tables used to pull in descriptions for associated 

items. 

 

Additional ap_invoice_d fields of interest: 

Div_level_1 – 4 Division for G/L posting 

Equip_id & eq_wo_id Equipment module posting information 

Full_account_id Full G/L account number with divisions 

Sales_tax_amount Sales tax from distribution 
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Table Name: gl_history 

 

FOUNDATION Location: General Ledger > Reports > History Detail 

 

Basic_account_id General ledger account number 

Amount_db Amount posted as a debit 

Amount_cr Amount Posted as a credit 

Date_booked Posting date 

Module_from Source module for transaction 

Job_id Job number posted to G/L 

 

 
 

Associated tables: 

 
The accounts table must be joined to the gl_history table by joining the gl_history.basic_account_id and 

accounts.account_id fields.  This is one of the only table joins that I have run across that does not have a 

direct relationship name-wise in both tables. 

Customers, Jobs, Equipment, Vendors: All tables used to pull in descriptions for associated items. 
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Table Name: gl_history_pr_dtl 

 

FOUNDATION Location: General Ledger > Reports > History Detail > drilldown to 

Payroll History within G/L history 

 

Basic_account_id G/L account number 

Job_id Job number 

Amount_db Amount posted as debit 

Amount_cr Amount posted as credit 

Employee_id Employee number 

Date_booked Date posted to general ledger 

 

 
 

Associated tables: 

 

Jobs, Employees, Accounts: all tables used to pull in descriptions for associated items 

 

Additional gl_history_pr_dtl fields of interest: 

 

Check_id P/R check number for the posting 

Full_account_id G/L account including division 

Gl_cash Cash account used for check posting 
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Table Name: his_timecard 

 

FOUNDATION Location: Payroll > Reports > Timecard History 

 

Employee_id Employee number 

Job_id Job number 

Dated Actual date of work on the timecard 

Hours Hours entered on timecard 

Earn_type_id Earn code 

Pay_rate Hourly pay rate 

amount Additional amount if not hourly 

 

 
 

Associated tables: 

 

Jobs, Employees, Unions, Trades: All tables used to pull in descriptions for associated items. 

 

Additional his_timecards fields of interest: 

 

Cost_code_id / cost_class_id Cost Code & Cost Class Number 

Union_id Union Number 

Trade_id Trade Number 

Equipment_id / service_code_id Equipment Service information 
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Table Name: his_misc 

 

FOUNDATION Location: Payroll > Reports > Miscellaneous Deduction History 

 

Employee_id Employee number 

Deduction_id Miscellaneous Deduction number / code 

Deduction_amount Amount withheld for this deduction code 

P401K_earnings 401K Earnings (401K codes only) 

P401K_matching 401K matching amount 

Dated Date posted to Payroll History (most likely check date) 

 

 
 

Associated tables: 

 

Employees (and other earning history tables): All tables used to pull in descriptions for 

associated items. 

 

Additional his_misc fields of interest: 

 

Integration_type For A/P integration 

Vendor_id Vendor number (for integration) 
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Table Name: his_earn_hours 

 

 FOUNDATION Location: Payroll > Reports > Earnings Detail 

 

Employee_id Employee number 

Earn_type_id Earn Code 

Hours Number of hours worked per earn code 

Dollars Summed value of dollars per earn code 

Dated Date posted (most likely check date) 

 

 
 

Associated tables: 

 

Employees: Used to pull in descriptions for associated items. 
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Table Name: his_earn_additional 

 

FOUNDATION Location: Payroll > Reports > Earnings Detail 

 

Employee_id Employee number 

Earn_type_id Earn Code 

Additional_dollars Additional earning amount 

Dated Date posted (most likely check date) 

 

 
 

Associated tables: 

 

Employees: Used to pull in descriptions for associated items. 
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Table Name: v_em_jc_billings 

 

FOUNDATION Location: Accounts Receivable > Reports > Applied History 

 

Job_id Job Number 

Customer_id Customer Number 

Invoice_id A/R Invoice number 

Amount_invoiced Amount Invoiced 

Cash_amount Amount of Cash Received 

Adjust_date Date of posting 

 

 
 

Associated tables: 

 

Jobs, Customers, ar_invoice: Used to pull in descriptions for associated items. 

 

This is a rather unique view table; it is very helpful when creating reports for cash receipts and 

billings by customer and jobs. 
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